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Abstrak 

Sistem Supervisory Control and Data Acquisition (SCADA) telah banyak 

digunakan dalam industri untuk memantau, mengendalikan, dan mengawasi berbagai 

proses secara efisien. Penelitian ini bertujuan untuk mengembangkan dan 

mengimplementasikan sistem SCADA pada modul pelatihan elevator 4 lantai 

menggunakan software CX Supervisor. Penggunaan SCADA diharapkan dapat 

meningkatkan pemantauan real-time, deteksi dini terhadap gangguan, serta respons yang 

lebih cepat terhadap masalah yang mungkin timbul.Modul pelatihan ini dirancang 

menggunakan PLC Omron CP1E sebagai pengendali utama, yang diintegrasikan dengan 

SCADA untuk memantau dan mengendalikan elevator. Fitur keamanan pada SCADA juga 

diuji untuk memastikan keefektifannya dalam menangani situasi beban berlebih. Hasil 

penelitian menunjukkan bahwa integrasi SCADA dalam modul pelatihan elevator 

memberikan peningkatan signifikan dalam kualitas pemantauan dan pengendalian sistem. 

Selain itu, sistem ini juga memberikan pengalaman belajar yang lebih mendalam bagi 

peserta pelatihan, mempersiapkan mereka untuk menghadapi tantangan di dunia industri 

yang sesungguhnya. 

Kata Kunci : SCADA,CX Supervisor, Monitoring,Elevator 4 lantai 

 

Abstract 

Supervisory Control and Data Acquisition (SCADA) systems have been widely 

used in industries to efficiently monitor, control, and supervise various processes. This 

research aims to develop and implement a SCADA system on a 4-floor elevator training 

module using CX Supervisor software. The use of SCADA is expected to enhance real-time 

monitoring, early detection of disturbances, and quicker responses to potential 

problems.The training module is designed using the Omron CP1E PLC as the main 

controller, which is integrated with SCADA to monitor and control the elevator. The 

security features of SCADA are also tested to ensure their effectiveness in handling 

overload situations.The research results show that the integration of SCADA in the elevator 

training module significantly improves the quality of system monitoring and control. 

Furthermore, this system provides a more in-depth learning experience for trainees, 

preparing them to face real-world industrial challenges. 

Keywords: SCADA, CX Supervisor, Monitoring, 4-floor Elevator 
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BAB I 

PENDAHULUAN 

1.1.Latar Belakang 

Lift adalah alat transportasi vertikal yang digunakan sebagai alat bantu untuk 

mempermudah aktifitas didalam gedung-gedung bertingkat.(Rahmadhani et al., 

n.d.)Lift dalam melakukan fungsi sebagai alat transportasi vertikal memerlukan 

sistem pengendalian.(Yudin et al., 2023)Oleh karena itu suatu sistem membutuhkan 

suatu pengaman yang handal yang mampu mendeteksi gangguan dan kesalahan 

yang terjadi pada sistem tersebut. Hal tersebut diperlukan agar sistem yang dimiliki 

mampu menjaga pelayanan.(Heru Susanto & Novery Lysbetti, 2016) Meskipun 

sistem lift telah banyak digunakan, masih terdapat kebutuhan untuk meningkatkan 

efisiensi dan keamanan dalam pengendaliannya. 

Banyak studi dan penggunaan teknologi baru telah dilakukan untuk 

pengendalian dan pemantauan. Penelitian sebelumnya menunjukkan bahwa 

penggunaan sistem SCADA bisa membuat pengendalian dan pemantauan lebih 

mudah. Penggabungan teknologi ini membantu meningkatkan kinerja proses 

pemilahan di berbagai industri.(budiman, n.d.), (Ahmed Eltahir Ali & Jiang Min, 

2013),(Eso & Eseosa, 2022) SCADA (Supervisory Control and Data Acquisition) 

yaitu salah satu teknologi yang sering digunakan di industri untuk mengawasi, 

mengendalikan, dan memantau sistem secara efisien.(Fauzan Akbar et al., 2023) 

SCADA biasanya digunakan untuk mengendalikan suatu proses di industri.(Halimi 

et al., 2020) 

Penggunaan teknologi SCADA dalam sistem lift memberikan potensi untuk 

meningkatkan pemantauan real-time, deteksi dini terhadap gangguan, dan respons 

yang lebih cepat terhadap masalah yang mungkin timbul. Pada salah satu penelitian 

modul latih yang berbeda sudah ada SCADA software yang digunakan yaitu 

Wonderware-InTouch (Ariefka Septian Putra et al., 2023) sedangkan pada 

penelitian modul latih elevator 4 lantai software yang digunakan yaitu CX 

Supervisor yang merupakan software yang digunakan untuk memantau dan 

mengontrol sistem otomasi industri. CX Supervisor sendiri merupakan perangkat 

lunak yang dikembangkan oleh Omron (Muchtar & ATI Makassar, 2023) sehingga 
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komunikasi dengan PLC Omron CP1E N40 yang hanya memiliki 2 serial 

komunikasi mudah untuk dilakukan. 

Penelitian ini bertujuan untuk mengembangkan dan mengimplementasikan 

sistem SCADA pada modul pelatihan elevator 4 lantai menggunakan software CX 

Supervisor dan melihat efektifitas SCADA dalam menangani situasi beban berlebih 

pada modul latih elevator 4 lantai. Tujuan utamanya adalah untuk meningkatkan 

kualitas pembelajaran, memberikan pengalaman dengan teknologi industri terkini, 

dan mempersiapkan peserta pelatihan untuk menghadapi tantangan dalam 

pengendalian dan pemantauan sistem lift di dunia nyata. Selain itu, penelitian ini 

juga bertujuan untuk mengevaluasi efektivitas integrasi SCADA dalam 

meningkatkan pemahaman konseptual dan keterampilan praktis peserta dalam 

mengelola sistem elevator 

1.2.Rumusan Masalah 

Berdasarkan latar belakang yang telah diuraikan, maka permasalahan yang akan 

dibahas dalam Tugas Akhir ini adalah sebagai berikut: 

1. Bagaimana menggunakan SCADA sebagai Monitoring Modul Latih Elevator 

4 Lantai? 

2. Bagaimana membuat Display SCADA yang dapat menjadi sistem monitoring 

bagi oprator? 

3. Apakah Fitur keamanan pada scada terbukti efektif dalam menangani situasi 

beban berlebih? 

1.3.Tujuan 

Berdasarkan permasalahan yang telah dirumuskan, tujuan yang ingin dicapai 

melalui Tugas Akhir ini adalah sebagai berikut: 

1. Menerapkan sistem SCADA sebagai Monitoring Modul Latih Elevator 4 Lantai? 

2. Membuat Display SCADA yang dapat menjadi sistem monitoring bagi oprator? 

3. Menerapkan Fitur keamanan pada scada terbukti efektif dalam menangani 

situasi beban berlebih? 

1.4.Luaran 

Pengerjaan Tugas Akhir ini diharapkan dapat menghasilkan luaran, antara lain: 

a. Modul Latih Elevator Pada Gedung Berbasis PLC dengan monitoring SCADA 

dan IoT. 
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b. Sistem Monitoring Modul Latih Elevator pada Gedung Berbasis SCADA dan 

IoT. 

c. SOP Modul Latih Elevator Pada Gedung Berbasis PLC dengan monitoring 

SCADA dan IoT. 

d. Laporan Tugas Akhir. 

e. Atikel ilmiah/Jurnal. 
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BAB V 

PENUTUP 

5.1.Kesimpulan 

Berdasarkan hasil evaluasi dari berbagai pengujian yang telah dilakukan, 

beberapa kesimpulan utama dapat dirumuskan sebagai berikut: 

1. Pengujian konektivitas transmisi data antara PLC Omron CP1E N40SDRA dan 

SCADA CX-Supervisor menunjukkan bahwa semua indikator pada plant 

terdeteksi dengan benar oleh SCADA dan Delay antara SCADA dan plant 

berkisar antara 1,01 hingga 1,07 detik. 

2. Display SCADA mencakup halaman utama, kontrol elevator, monitoring, dan 

alarm. Halaman monitoring menampilkan parameter plant elevator dengan 

keterangan setiap unit beban. Sensor beban elevator memiliki batas 1 kg. Relay 

kabin aktif saat beban mencapai 1 kg. 

3. Sensor beban dengan batas 1 kg efektif mendeteksi beban berlebih. Pada 1000 

gram, alarm aktif dan tercatat di datasheet SCADA. Datasheet mencakup 

tanggal, waktu, pesan, prioritas, dan status alarm. Sistem ini memungkinkan 

pemantauan dan analisis jangka panjang yang komprehensif. 

5.2. Saran 

1. Monitoring berat beban secara analog pada kabin elevator dapat di tampilkan 

pada SCADA.  

2. Penggunaan fitur seperti kamera dan sensor asap di dalam kabin elevator. 
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Lampiran 1 Jobsheet Scada. 

JOBSHEET 6 

Membuat Project Baru 

1.1.Tujuan Pembelajaran 

 

Setelah membaca jobsheet 6, pembaca dapat membuat project baru pada 

software Cx-Supervisor. 

 

1.2.Langkah Kerja 

 

Langkah-langkah dalam membuat project baru adalah: 

 

1. Buka CX-Supervisor ,Seteleh di buka pilih File => New Project => Cx-

Supervisor Plus Project...” seperti gambar di bawah: 

 

2. Lalu Save Project seperti gambar di bawah:  
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3. Selanjutnya sesuaikan Ukuran Display agar sesuai dengan PC dengan cara Pilih 
File=> Page Propetis lalu pada bagian Border Styl pilih “Thin” Display “Replace” lalu  
klik “Full Size” Terakhir Tekan “OK” 

 

 

4. Tampilan awal Scada CX-Supervisor akan menjadi gambar di bawah : 

 
5. Tekan Save Pada menu Toolbar
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JOBSHEET 7 

Pengaturan Komunikasi 

 

2.1. Tujuan Pembelajaran 
Setelah membaca jobsheet 2, pembaca dapat melakukan pengaturan untuk 

komunikasi cx-supervisor dengan PLC Omron. 

2.2. Langkah Kerja 

Langkah-langkah dalam melakukan pengaturan komunikasi adalah: 

1. Pilih Icon  => Add => Cx-Server (FINS)  

*Karna kita menggunakan PLC ber merk Omron Maka Device yang di pakai 

Yaitu Cx-Server (Fins) bila PLC yang di gunakan diluar merk Omron Maka 

menggunakan “Sysmac Device” 

 

 

2. Lalu Pilih jenis PLC yang digunakan ,Type CPU, Dan Media Transmisi Ynag 
akan di gunakan lalu tekan “OK” seperti gambar di bawah: 
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3. Selanjutnya Pilih Icon Untuk Membuat Variable Text=> Add Point =>Pada 
I/O Type Pilih “Input/Output” => Pada I/O Atributes Pilih PLC => Setup...=> 
akan Muncul Tampilan PLC Atribute => add PLC=> Sesuaikan seperti gambar 
point no 2=>Tekan OK 

 

 

4. Untuk Membuat Variable Tag Modul Latih Elevator 4 Lantai Buat Variable Tag 
seperti Gambar Di bawah: 
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JOBSHEET 8 

Membuat Tampilan Kontrol dan Monitoring Elevator 4 lantai 

 

 

3.1. Tujuan Pembelajaran 
Setelah membaca jobsheet 3, pembaca dapat membuat tampilan kontrol dan 

monitor pada cx-sepervisor. 

3.2. Langkah Kerja 

Langkah-langkah dalam membuat tampilan kontrol adalah: 

 

1. Pada tampilan kosong, tampilan ini akan diisi dengan Switch, Lamp, 

Numeric Display, dan Trads. 

 

 

2. Tambahkan Switch dengan klik Icon “ ”  setelah sudah muncul  

tombot klik 2x => akan muncul menu “Toggle Buttom Wizard” lalu 

pada Button Style pilih Button yang sesuai=> Isi Bolean Poin dengan 

Variable Tag  yang telah di buat => tekan browse... =>Select Required 

item=> Cari Variable Tag pada  Point.

switch 

Lamp 

Numeric Display 

Trads 
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3. Selanjutnya Tambahkan Lampu dengan mengklik Icon  => Akan Muncul 
Graphic Liblary=Cari lampu*disini mengguanakan NS Lamps(Circeles)=>Seret 
Gambar Lampu yang di inginkan ke Display=>secara Otomatis tampilan “Point 
Subtation” akan muncul=> browse...=> Cari Variable Tag yang telah di buat. 

 

4. Ulangi langkah 1 sampai 3 jika diperlukan. 

5. Klik OK setelah selesai. 



51 
 

 
POLITEKNIK NEGERI JAKARTA 

 

6. Selanjutnya Tekan Icon =>Klik Display masukan text “##”=>Klik 2x Text 
“##”=>Animation Editor=>Display Value(Text)=>Browse...=>Select Required 
Item=Pilig Point Name dengan Variable Tag Yang telah di buat. 

 
 

7. Ulangi langkah 6 bila diperlukan. 

8. Selanjutnya Tekan Icon =Klik Display=>Muncul Trads=>Klik 2x Trads=> Trads 
Graph Wizart=Scaling=Sesaikan=>Ok=Trand Graph Wizard=> Brows=>Select Required 
Item=>Pilih Variable Tag=>Ok 
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9. Klik OK setelah selesai. 

 

 

 

10. Buatlah seperti tampilan diatas dan masukan variable tag sesuai  fungsi
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JOBSHEET 9 

Membuat Tampilan Alarm 

 

 

4.1. Tujuan Pembelajaran 

 

Setelah membaca jobsheet 1, pembaca dapat membuat alarm pada software cx-

supevisor. 

4.2.Langkah Kerja 

 

Langkah-langkah dalam membuat tampilan dan script RFID adalah: 

1. Buat Variable Tag Alarm dengan cara klik icon work space => 

Pilih bagian alarm => pada tampilan workspace=>Klik Kanan=>add 

alarm=>Masukan nama alarm,priority,dengan alarm type simple=>Pilih 

variable Tag yang akan di gunakan Untuk Alarm=>pilih browse=>Select 

Requitmen Item =>ceklis Exclude System Point=>OK 
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2. Selanjut klik icon Alarm lalu => klik  halaman display akan muncul display 

alarm =>klik 2x display alarm untuk membuka halaman alarm wizard 

=>sesuaikan alarm wizard=> Tekan OK 

 

3. Klik Save lalu tekan icon runtime=> Tekan Yes pada setiap Pop Up=>Klik 

kanan pada display =>pilih alarm History Log=>Lalu akan muncul History 

alarm seperti pada di gambar 

Klik kanan 

pilih add 
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Klik Kanan 



56 
 

 
POLITEKNIK NEGERI JAKARTA 

 

JOBSHEET 10 

Membuat database dan mc.acces 

5.1. Tujuan Pembelajaran 
Setelah membaca jobsheet 1, pembaca dapat membuat dattabase pada software 

Cx-supervisor. 

5.2. Langkah Kerja 

Langkah-langkah dalam membuat alarm adalah: 

1. Buat File Ms.Acces dengan cara Buca Ms.acces=> pada menu Home pilih 
Blank Dokumen=>Pilih icon Folder=>pada colom save as tyepe pilih type 
yang memiliki (.mdb)=>OK=>Create. 

 

 

 

2. Akan muncul seperti tampilan di bawah=>pada workspace ms.acces klik 
kanan=>pilih design View 

 
 

 

3. Lalu akan muncul seperti tampilan di bawah => Isi colom sesuai dengan 
Kebutuha
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4. Tekan Save,Lalu keluar. 
5. Buka kembali Cx-Supervisor =>Pada work space Pilih 
database=>Klik kanan pada tampilan workspace =>add Conection=>pada bagian 
data source pilih icon ...=> Pilih Ms.acces yang sudah di buat =>Open=>Ok 

 

 

6. Klik Kanan Lalu ceklis connec=>add Rechordset=>Pilih Nama 
Table Pada ms.acces=>Lalu OK=>Lock tandai Optimistic=>Type Table Name. 

 
7. Klik kanan pada Rechordes yang di buat tadi=>Pilih add 
Fieled=>Sesuaikan bagian Fieled dengan ms.acces=>Pilih brows untuk memilih 
point name. 
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8. Buat Rechordes baru =>Copy paste Field yang telah dibuat => Ubah Bagian 
Field Property sesuaikan Dengan jenis Point. 

 
9. Pada workspace pilih Pages=>klik kanan Project Script=>add project 

script=>pilih menu 
special=>database=>DBAddNew=>Special=>database=>DBExecute=>pecial=>
database=>DBMove=>Script Code isi cx-supervisor script=>Triger Event 
sesuaikan kebutuhan=>expression pilih pilih variable tag yang telah di buat. 

 

 

10. Save 
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